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Знакомство с программой Microsoft Internet Explorer 5.0.
Для работы в Интернете необходим простой и понятный инструмент, позволяющий использовать все возможности сети. Выбор такого инструмента является важной задачей. Наиболее популярным в последнее время становится пакет программ Inernet Explorer [Интернет Эксплорер], разработанный фирмой Microsoft. Если и еще не выбрали инструмент для работы в Интернете, то наиболее подходящая программа Microsoft Internet Explorer 5.0. Ее выбор обусловлен несколькими факторами: 
В настоящее время Internet Explorer является одной из самых популярных программ для работы в сети Интернет, а четвертая версия - самой распространенной версией программы. Активная рекламная компания фирмы Microsoft способствует быстрому распространению программ на офисных и домашних компьютерах. Кроме того. Internet Explorer теперь является составной частью операционной системы Windows 98. 
Эта программа максимально интегрирована в операционную систему Windows и наиболее полно использует ее возможности. 
В отличие от конкурирующих программ существует русская версия Internet Explorer. To, что все сообщения и команды программы отображаются на русском языке, значительно облегчает работу в Интернете начинающим пользователям в нашей стране. 
По сравнению с основным конкурентом - программой Netscape Communicator в Internet Explorer более удачно реализована возможноcть просмотра текстовой информации в Интернете, представленной в различных кодировках. Проще говоря, используя Internet Explorer, легче работать с русскоязычной информацией в Интернете. 
Программа распространяется совершенно бесплатно, и вы можете легко получить ее у вашего поставщика услуг Интернета или у вашего знакомого. Зарегистрировавшись у фирмы Microsoft, вы бесплатно станете легальным пользователем. Кроме того, как уже упоминалось. Internet Explorer в настоящее время включается в стандартный комплект поставки Windows, так что при покупке компьютера с установленной операционной системой Windows вы, возможно, сразу получите данную программу. Также вы можете переписать Internet Explorer 5,0 и все новые версии этой программы через сеть Интернет непосредственно у фирмы Microsoft Для этого вам необходимо подключиться к Интернету и перейти на страницу с адресом, после чего выбрать интересующую вас версию программы и, следуя появляющимся инструкциям, переписать ее на свой компьютер. 
  Основным сервисом в Интернете в последнее время стала Всемирная паутина WWW, поэтому главной программой пакета Internet Explorer является программа просмотра Web-страниц, называемая browser [броузер, или браузер]. Часто в русской документации эту программу называют проводником, подразумевая, что она проводит вас в мир Интернета. 
  Итак, Internet Explorer 5.0 - проводник Интернета, поддерживающий все новые возможности, закладываемые разработчиками Web-страниц, включая звуковое и видеосопровождение отображаемой информации. Internet Explorer поддерживает современные стандарты шифрования информации помимо этого реализована возможность пересылки конфиденциальных данных. Это позволяет значительно повысить безопасность передаваемой по сети информации. 
  Однако Интернет - это не только Всемирная паутина. Значительный объем информации, передаваемой в сети, представляет собой электронную почту я новости. В комплект Internet Explorer входит программа для работы с электронной почтой и электронными новостями Outlook Express [Аутлук Экспресс], которая поддерживает стандартные почтовые протоколы Интернета, а также протоколы распространения электронных новостей.
  Также в комплект Internet Explorer входит программа Microsoft NetMeeting [Майкрософт Нетмитинг], которая позволяет реализовать дополнительные возможности, предоставляемые сетью Интернет. Microsoft NetMeeting позволяет устанавливать голосовую связь и обмен разнообразными данными через Интернет. У вас появляется возможность пользоваться устройством, объединяющим телефон и большой -набор средств обмена данными. Вы можете разговаривать со своим собеседником и использовать общую доску Для рисования, позволяющую вместе создавать рисунки. Также существует возможность подключить к вашему разговору других абонентов Интернета и организовать конференцию. Кроме того, у вас появляется возможность совместно использовать офисные приложения, например, вдвоем работать над текстом в редакторе Word. Одновременно с вышеперечисленными возможностями вы сможете передавать и получать любые файлы. 
   В полный комплект Internet Explorer включается также поддержка Active-Movie [Эктив муви]. Этот продукт способен демонстрировать видеофильмы, воспроизводить звуки, оживлять рисунки, то есть реализовывать возможности мультимедиа в Интернете. 
  Как уже отмечалось, комплект программ Internee Explorer в настояще время является наиболее распространенным и универсальным средство для работы с Интернетом. Основная идея программы заключается в том что пользователь должен чувствовать себя в Интернете так же уверение как и за своим компьютером. Поэтому работа с Интернетом не должн отличаться от работы с другой информацией на вашем компьютере- Inter net Explorer 5.0 не просто встроен в операционную систему, а стал ее не отъемлемой частью. На вашем компьютере просто появится еще один дне с именем Internet. Вы можете копировать, изменять, редактировать pecyрсы Интернета, используя стандартные средства операционной систем Windows. Работа в Интернете будет выполняться в проводнике Windov так же, как работа с файлами вашего компьютера. 
  Содержание любой папки на рабочем столе Windows отображается в BI' списка имен файлов, либо в виде набора значков. Для перехода в реж Web достаточно один раз щелкнуть кнопкой мыши на требуемом значв При этом можно будет заметить, что файлы отображаются в виде ссылок) рамках полноценной страницы Web с графическими изображениями текстовыми описаниями, которые не оставляют ни малейшего сомнения том, для чего предназначена ссылка.
  В данной главе описывается только проводник Internet Explorer. С программой Outlook Express вы познакомитесь во время изучения глав, посвященных электронной почте, новостям и другим возможностям Интернета.
  Если вы работаете в операционной системе Windows 98, то Internet Explorer 4.0 уже установлен на вашем компьютере. Однако, если вы хотите пользоваться самой последней версией Internet Explorer 5.0, то вам необходимо установить его дополнительн Если вы еще не установили пакет Internet Explorer 5.0, то сейчас настя время сделать это. Лучше установить сразу полный вариант, чтобы не иД кать в дальнейшем различные дополнительные компоненты. Установ ничем не отличается от установки любой программы для Windows, однак отметим некоторые особенности, которые необходимо учитывать при тановке Internet Explorer 5.0. 
  Если вы работаете в операционной системе Windows 98, то Internet Explorer 4.0 уже установлен на вашем компьютере. Однако, если вы хотите пользоваться самой последней версией Internet Explorer 5.0, то вам необходимо установить его дополнительн Если вы еще не установили пакет Internet Explorer 5.0, то сейчас настя время сделать это. Лучше установить сразу полный вариант, чтобы не иД кать в дальнейшем различные дополнительные компоненты. Установ ничем не отличается от установки любой программы для Windows, однак отметим некоторые особенности, которые необходимо учитывать при тановке Internet Explorer 5.0. 
В зависимости от того, какие компоненты Internet Explorer 5.0 вы захотите устанавливать, вам потребуется от 50 до 100 мегабайт свободна места на жестком диске вашего компьютера. Если места недостаточно то программа установки предупредит вас об этом. 
Следует помнить, что вы можете выбирать тип установки Internet Explorer 5.0: полная версия, стандартная версия, минимальная версия. всех версиях существует проводник Интернета, а остальные компоненты пакета могут поставляться отдельно. 
Перед установкой комплекта Internet Explorer 5.0 следует настроить связь с Интернетом. О том, как это делается в Windows 95/98, было рассказано в предыдущей главе. 
Если у вас установлена английская версия Internet Explorer 5.0, рекомендуем заменить ее русской версией (если вам удобнее работать с русским языком, а не с английским). И, если у вас установлена более ранняя версия проводника, лучше поменять ее на пятую. 


  







Установка программы Internet Explorer.
Чтобы начать установку, необходимо иметь компакт-диск, на котором обычно распространяется программа Internet Explorer. Вторым способом установки является использование Интернета. В этом случае вам необходимо переписать на ваш компьютер маленькую программу установки и запустить ее. Программа установки сама перепишет необходимые компоненты из Интернета. 
Чтобы начать установку, нажмите кнопку Пуск (Start) на Панели задач (Taskbar) операционной системы Windows. Откроется основное меню. 
Выберите команду Выполнить (Run) в открывшемся меню. Появится диалог Запуск программы (Run). 
Нажмите кнопку Обзор (Browse). Откроется диалог Обзор (Browse). 
Найдите место на вашем компьютере, где расположена программа установки ie5setup.exe программы Internet Explorer, и нажмите кнопку Открыть (Open) для возврата к диалогу Запуск программы (Run). 
Нажмите кнопку ОК в диалоге Запуск программы (Run). Программа установки будет запущена. 
  После запуска программы установки появится диалог, и вам будет предложено ознакомиться с лицензионным соглашением на использование Internet Explorer. 
Установите переключатель в положение Принимаю (I Accept) и нажмите кнопку Далее (Next), чтобы закрыть диалог. Тем самым вы принимаете условия этого соглашения, и установка программы будет продолжена. Появится диалог Выбор компонент (Component Options). 
Существует несколько видов установки. В верхнем открывающемся. списке выберите элемент Обычный набор (Typical) и нажмите кног Далее (Next). Появится очередной диалог мастера установки. 
Подготовительный этап завершен. Нажмите кнопку Далее (Next), бы начать установку Internet Explorer. 
Процесс установки сопровождается изменением прогресс-индикатора. По окончании установки вам будет предложено перезагрузить компьютер с помощью кнопки Готово (Finish). 
  После перезагрузки компьютера на рабочем столе Windows появится значок Internet Explorer, а также пункты Internet Explorer, Outlook Express, Адресная книга (Adress book) в главном меню Windows Пуск Программы (Run > Programs). Теперь вы можете приступать к практическому знакомству с программой Internet Explorer.






















Первый запуск программы.
Нажмите кнопку Пуск (Start) на Панели задач (Taskbar). Откроется основное меню Windows. 
Выберите команду Программы > Internet Explorer (Programs > Internet Explorer) главного меню Windows. Программа будет запущена. 
  При первом запуске программы Internet Explorer будет вызван мастер Подключение к Internet (Internet Connection Wizard).
  Мастер - последовательность диалогов Windows, которая ведет вас к назначенной цели. С его помощью можно настроить параметры подключения сети, если это не было сделано ранее. При последующих запусках программы Internet Explorer этот мастер вызываться не будет.
  Так как в предыдущей главе мы уже установили необходимые парамет для работы с Интернетом из Windows, то подключение к сети Интернет настроено. Если же вы не настроили подключение, то вам необходи выполнить опыты из главы "Настраиваем Windows 95/98 для работы в Интернете" самоучителя. 
Установите переключатель в нижнее положение и нажмите кнопку Далее (Next). Появится диалог о выборе типа подключения. 
Установите переключатель в положение, соответствующее вашему типу подключения к Интернету и нажмите кнопку Далее (Next), чтобы продолжить работу. Появится диалог Настройка учетной записи электронной почты (Set Up Your Internet Mail Account) 
Поскольку в данной главе мы не будем использовать электронную почту, то установите переключатель в положение Нет (No). Параметры электронной почты мы настроим позднее, во время изучения программы Outlook Express. 
Нажмите кнопку Далее (Next). Появится диалог с сообщением о завершении мастера подключения к Интернету. 
Нажмите кнопку Готово (Finish), чтобы завершить работу мастера. После закрытия диалога будет запущена программа Internet Explorer. 
  Программа Internet Explorer по умолчанию настроена так, что при каждом запуске для подключения к сети Интернет она будет вызывать диалог Установка связи (Connect To). Если у вас этого не происходит не расстраивайтесь: ниже будет рассмотрено, как это сделать самостоятельно. Чтобы первый раз ознакомиться с программой Internet Explorer нет необходимости подключаться к сети Интернет. Кроме того, знакомство с программой может занять продолжительное время и, если вы будет подключены к сети Интернет, то это время вам придется оплатить. 
Если при запуске Internet Explorer появился диалог Установка связи(Connect To), нажмите кнопку Отмена (Cancel) этого диалога для должения знакомства без подключения к сети Интернет. 
  Поскольку мы не подключились к Интернету, то при запуске программы вы увидете сообщение. В данном случае http://home.microsoft.com/intl/ru - адрес начальной веб-страницы, на которую настроена программа Internee Explorer. Это страница фирмы Microsoft на русском языке. Для английской версии программ будет настроена на английскую страницу. Если в программе настроена другая начальная страница, то вы увидите ее адрес в сообщении. 
Нажмите кнопку ОК диалога Microsoft Internet Explorer, чтобы его закрыть. Будет открыто рабочее окно программы Internet Explorer.














Предварительная настройка программы.
На рабочем столе Windows есть значок Internet Explorer. 
Дважды щелкните мышью на значке Internet Explorer, чтобы запустить эту программу. 
Выберите команду меню Сервис > Параметры обозревателя (Tools > Internet Options) программы Internet Explorer. Откроется диалог Параметры обозревателя (Options). 
  Группа элементов управления Панель инструментов (Toolbar) предназначена для настройки внешнего вида рабочего окна программы Internet Explorer. Чтобы не отображать какой-либо из указанных элементов, ну убрать соответствующий флажок. 
Установите все флажки в данной группе элементов управления, если они еще не установлены. 
Щелкните мышью на ярлычке Подключение (Connection), чтобы перейти на эту вкладку. 
  Группа элементов управления Подключение (Connections) предназначена для настройки подключения вашего компьютера к Интернету. В данном случае Internet Explorer использует для такой настройки встроенные средства Windows (рассмотренные в главе "Настраиваем Windows 95/98 для работы в сети Интернет").
  Группа элементов управления Прокси-сервер (Proxy Server) предназначена Для настройки параметров прокси-сервера вашего провайдера. 
  Прокси-сервер представляет собой промежуточное звено между вашим компьютером и сетью Интернет. Если ваш поставщик предоставляет такую возможность, использование прокси-сервера позволяет сделать работу в Интернете более удобной. Одной из функций прокси-сервера является запоминание всей информации, получаемой не только вами, но и другими абонентами, подключенными к нему. При каждом обращении к новой Web-странице или другой информации проверяется, а не запрашивал ли эту Web-страницу какой-либо абонент ранее. Если да, то эта страница ищется на диске сервера вашего поставщика услуг Интернета и передается на ваш компьютер. Если нет - тогда запрос на поиск нужной Web страницы направляется в сеть Интернет. 
  Кроме этого прокси-сервер предоставляет и другие возможности. О параметрах настройки прокси-сервера (если он используется) вам необходим узнать у своего поставщика услуг Интернета. 
Сбросьте флажок Подключение через прокси-сервер (Connect through a Proxy Server), если он был установлен. 
Щелкните мышью на ярлычке Общие (General), чтобы перейти вкладку с основными элементами управления для настройки программы. 
  Группа элементов управления Домашняя страница (Ноmе Раgе) позволит установить адрес Web-страницы, доступ к которой будет происходить тематически при запуске Internet Explorer. Обращение к данной Web-странице также возможно путем щелчка мышью на кнопке Домой (Ноme) на панели инструментов Internet Explorer. 
Убедитесь, что в поле ввода Адрес (Address) указан адрес ссылки http://www.msn.com/intl/ru. При необходимости щелкните мышкой на этом поле и введите данный адрес с клавиатуры. 
  Во время работы с Интернетом вы можете в качестве адреса ссылки использовать адрес страницы, отображаемой в настоящий момент в поле просмотра Internet Explorer. Чтобы в качестве адреса ссылки использовать адрес этой страницы, нужно нажать кнопку С текущей (Use current).
  Чтобы в качестве адреса ссылки использовать адрес, установленный разработчиками программы, нужно нажать кнопку С исходной (Use default).
  Программа Internet Explorer сохраняет адреса просмотренных веб-страниц. Группа элементов управления Журнал (History) npедназначена для настройки сохраненных адресов просмотренных веб-страниц в папке журнала. 
  Поле Сколько дней хранить ссылки (Days to keep pages in History) задает интервал времени, по истечении которого адреса Web-страниц будут yдалены из папки журнала. По умолчанию это время составляет двадцать дней, однако, мы рекомендуем выставить его равным одной неделе, есть семи дням. Вы можете изменить это время по своему усмотрению.
Чтобы установить конкретное значение времени, щелкните мышью в поле, где указано время, и наберите на клавиатуре цифру семь или подведите указатель мыши к счетчику и, щелкая на кнопки со стрелками, установите требуемое время. 
  Кнопка Стереть (Clear History) служит для удаления всех адресов папки. 
Нажмите кнопку ОК, чтобы закрыть диалог Параметры (Options) продолжить работу. 
  Перед тем, как начать работать в Интернете, полезно ознакомиться с основными принципами и приемами работы с программой Internet Explorer.






















Основные принципы работы с программой.
После знакомства с элементами окна Internet Explorer и предварительно настройки рассмотрим основные принципы работы с программой. Возможно, некоторая информация в этом разделе будет повторением основных принципов работы с Интернетом, изложенных в предыдущих главах, но для осознанной работы с программой Internet Explorer следует прочитать данный раздел.
  Одним из главных понятий при работе с Internet Explorer является понятие Web-страницы. Под страницей понимается документ, который содержит в себе кроме текста еще и графические изображения, звуковое сопровождение и даже видео-изображения. Кроме того, Web-страница может содержать ссылки на другие страницы или почтовые ящики. В зависимости с настройки программы такие ссылки обычно выделяются в документе цветом или подчеркиванием. Чтобы узнать, является фрагмент ссылкой или нет, подведите указатель мыши к интересующему вас участку. Это може быть текст или графическое изображение. Указатель мыши, проходя над ссылкой, должен изменить свою форму на стилизованное изображение руки , а в строке состояния будет отображен адрес перехода, соответствующий ссылке. 
  Работа программы начинается с загрузки на ваш компьютер начальной страницы. По умолчанию, ею является страница приветствия фирмы Microsoft. Вы можете назначить в качестве начальной любую Web-страницу, например, страницу вашего поставщика услуг Интернета. Это удобно для просмотра самых свежих новостей о работе вашего поставщика или вашей учетной информации, то есть, сколько времени вы работали, сколько времени или денег осталось на вашем счету и тому подобное.
  В процессе работы вы можете прервать процесс загрузки Web-страницы на ваш компьютер. Для этого вам необходимо нажать кнопку Стоп (Stop). Если нажать кнопку Обновить (Refresh), то текущая Web-страница будет заново загружена из сети. Это может быть полезным для просмотра страницы, загрузка которой была прервана кнопкой Стоп (Stop).
  Для отображения других Web-страниц вы должны или ввести в поле адре са новый адрес, или указателем мыши выбрать интересующую вас ссылк) в текущей Web-странице и щелкнуть на ней мышью. После того, как укажете адрес, происходит поиск Web-страницы в сети Интернет и ее грузка. Вы можете сохранить эту страницу на своем компьютере для да нейшего использования, если она вас заинтересовала, с помощью комаи меню Файл > Сохранить как файл (File > Save As File).
  Таким образом, работа с программой представляет собой перемещение бесконечной паутине ссылок на различные Web-страницы в Интернет. Для облегчения такого перемещения можно воспользоваться кнопкам Назад (Back) и Вперед (Forward), Для перехода на начальную страницу пользуйтесь кнопкой Основная (Ноmе). Очень полезной является способность программы Internet Explorer запоминать введенные вами с клавиатуры адреса в поле Адрес (Address). Пользуйтесь кнопкой с правой стороны поля ввода адреса, чтобы выбрать из списка нужный вам адрес.
  При вводе адреса с клавиатуры велика вероятность допустить ошибку. При этом вы получите сообщение о том, что адрес не найден. этом случае повторите ввод адреса еще раз, более внимательно.
  Во время сеанса работы, то есть с момента запуска программы Internet Explorer и до выхода из нее, можно повторно вызвать уже посещенные вами Web-страницы с помощью кнопок Назад (Back) и Вперед (Forward).













Первый выход в Интернет.
Поскольку мы познакомились с основными возможностями и принципами работы с Internet Explorer, настало время совершить первое подключение к сети Интернет. 
  Этот и последующие опыты требуют подключения к Интернету. Качество подключения может зависеть от многих факторов. Если во время выполнения какого-либо урока у вас возникнут проблемы, например, начальная страница будет грузиться очень долго или переходы не будут выполняться, отключитесь от сети Интернет, прочитайте урок до конца и попробуйте повторить снова. 
  Целью данного опыта является практическое закрепление основных принципов работы с программой Internet Explorer. Web-страницы постоянно совершенствуются их авторами, поэтому во время выполнения вами опытов, внешний вид некоторых Web-страниц может отличаться от приведенных в самоучителе. 
Установите связь с провайдером. 
Если программа Internet Explorer еще не запущена, запустите ее. Для этого дважды щелкните мышью на значке Internet Explorer, который находится на рабочем столе Windows. 
  После запуска Internet Explorer на ваш компьютер начнет загружаться начальная Web-страница . Видно, что эта Web-страница состоит из одного рисунка, изображающего земной шар, и текста приветствия, который содержит несколько ссылок на другие Web-страницы. Ссылки в тексте выделены цветом и подчеркиванием. 
Подведите указатель мыши к тексту Выберите данную ссылку для чтения учебника по Web. 
  Еще раз напоминаем, что внешний вид некоторых Web-страниц может отличаться от приведенных в настоящем самоучителе. Если вид начальной страницы Microsoft не соответствует приведенному в настоящем самоучителе, просто выберите первую встретившуюся в тексте ссылку.
  Как уже отмечалось, указатель мыши, проходя над ссылкой, изменит свою форму на стилизованное изображение руки, а в строке состояния будет отображен адрес перехода, соответствующий ссылке. 
Щелкните мышью на фразе Выберите данную ссылку для чтения учебника по Web. Начнется загрузка на ваш компьютер новой Web страницы. 
Нажмите кнопку Назад (Back), чтобы вернуться к начальной веб-странице . Обратите внимание, что загрузка начальной Web-страницы происходит значительно быстрее, чем в первый раз. Это связано с тем, что Internet Explorer загружает ее из папки временных файлов на вашем жестком диске. 
  Для ускорения работы программа Internet Explorer сохраняет все загруженные вами документы Интернета в специальной папке. Более подробно об этом будет рассказано ниже. 
  Обратите внимание, что кнопки Вперед (Forward) и Назад (Back) стали яркого цвета. Это говорит о том, что теперь ими можно пользоваться. 
Нажмите кнопку Вперед (Forward), чтобы вернуться к учебнику по Web. 
Подведите указатель мыши к рисунку, изображающему человека, стоящею перед указателем, и щелкните мышью на этом рисунке. По окончании загрузки Web-страницы Введение на вашем компьютере находится уже три разных Web-страницы. 
Нажмите кнопку Начальная (Ноmе). Вы снова перешли на первую Web-страницу. 
  Программа Internet Explorer сохраняет в поле адреса определенное количество адресов, введенных вами с клавиатуры. Давайте проведем небольшой эксперимент. 
Щелкните мышью в поле ввода Адрес (Address), которое находится чуть ниже панели инструментов. 
С помощью клавиш 'backspace' и 'delete' удалите старый адрес в поле ввода. 
Введите с клавиатуры адрес http://www.microsoft.com. 
После окончания ввода адреса нажмите клавишу 'enter'. Будет осуществлен переход на страницу с указанным адресом. 
Нажмите кнопку Начальная (Ноmе), чтобы опять перейти на начальную страницу. 
Нажмите стрелочку в правой части поля ввода адреса. Откроется список с введенными ранее адресами . 
Выберите адрес http://www.microsoft.com. Будет осуществлен переход сразу на третью Web-страницу. Содержимое этой страницы отобразится в поле просмотра. 
Дополнительные настройки.
Выполняя предыдущие опыты, вы могли заметить, что время от времен" мы возвращались к настройке программы Internet Explorer. В результате программа оказалась настроенной определенным образом и с ней можно достаточно эффективно работать в Интернете.
  Однако мы рассмотрели далеко не все настройки программы. Кроме "основных" настроек, без которых невозможно добиться эффективной работы в сети Интернет, существует множество параметров программы, настроив которые вы будете чувствовать себя намного комфортнее при работе с ней.
  Выполнение данного урока не является обязательным. Вы можете вернуться к нему позднее, если захотите глубже разобраться в программе Internet Explorer. 
Запустите программу Internet Explorer. Для этого дважды щелкните мышью на значке Internet Explorer на рабочем столе Windows. 
Как вы уже знаете, настройка программы Internet Explorer осуществляется с помощью диалога Параметры обозревателя (Internet Options), который вызывается командой меню Сервис > Параметры обозревателя (Tools > Internet Options). Откроется диалог Параметры обозревателя (Internet Options). 
Щелкните мышью на ярлычке Общие (General), чтобы перейти на эту вкладку. 
Нажмите кнопку Цвета (Colors), чтобы открыть диалог, который позволит вам настроить цветовую гамму рабочего окна программы. Для начала лучше не менять цвета. 
Установите флажок в поле Цвета Windows (Use Windows colors), если он не установлен. В этом случае при работе программы Internet Explorer будут использоваться такие же цвета, как и в других программах Windows.
[bookmark: _GoBack]  Группа элементов управления Ссылки (Links) позволит вам настроить цвет, используемый для выделения ссылок в тексте просматриваемой Web-страницы, а также установить или убрать подчеркивание для ссылок. Различают два вида ссылок: просмотренные, то есть те, на адреса которых уже был переход, и непросмотренные. У вас есть возможность настроить цвет для каждого типа ссылок, чтобы легко отличать их.
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